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1. Related Manuals 
 
To ensure system safety, make sure to always read and heed the information provided in all 
Safety Precautions and Precautions for Safe Use of manuals for each device which is used in 
the system.  
The table below lists the manuals of IAI Corporation (hereinafter referred to as IAI) and 
OMRON Corporation (hereinafter referred to as OMRON) related to this document.  
 

Manufacturer Cat. No.  Model Manual name 
OMRON W500 NJ501-[][][][] 

NJ301-[][][][] 
NJ-series CPU Unit Hardware User’s 
Manual 

OMRON W501 NJ501-[][][][] 
NJ301-[][][][] 

NJ-series CPU Unit Software User’s 
Manual 

OMRON W505 NJ501-[][][][] 
NJ301-[][][][] 

NJ-series CPU Unit Built-in EtherCAT(R) 
Port User’s Manual 

OMRON W504 SYSMAC-SE2[][][] Sysmac Studio Version 1 Operation 
Manual 

IAI ME0313 XSEL-R/S/RX/SX/RXD/SXD X-SEL Controller R/S/RX/SX/RXD/SXD 
Type Operation Manual 

IAI ME0309 XSEL-R/S/RX/SX/RXD/SXD EtherCAT(R) Operation Manual 
XSEL-R/S/RX/SX/RXD/SXD 

IAI ME0154 IA-101-X-MW 
IA-101-XA-MW 
IA-101-X-USBMW 

PC Software for X-SEL Operation Manual 
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2. Terms and Definitions 
 

Term Explanation and Definition 
PDO Communications 
(Communications using 
Process Data Objects) 

This method is used for cyclic data exchange between the 
master unit and the slave units.  
PDO data (i.e., I/O data that is mapped to PDOs) that is 
allocated in advance is refreshed periodically each EtherCAT 
process data communications cycle (i.e., the period of primary 
periodic task).  
The NJ-series Machine Automation Controller uses the PDO 
Communications for commands to refresh I/O data in a fixed 
control period, including I/O data for EtherCAT Slave Units, and 
the position control data for the Servomotors.  
It is accessed from the NJ-series Machine Automation 
Controller in the following ways.  
・With device variables for EtherCAT slave I/O 
・With Axis Variables for Servo Drive and encoder input slave to 

which assigned as an axis 
SDO Communications 
(Communications using 
Service Data Objects) 

This method is used to read and write the specified slave unit 
data from the master unit when required.  
The NJ-series Machine Automation Controller uses SDO 
Communications for commands to read and write data, such as 
for parameter transfers, at specified times.  
The NJ-series Machine Automation Controller can read/write 
the specified slave data (parameters and error information, etc.) 
with the EC_CoESDORead (Read CoE SDO) instruction or the 
EC_CoESDOWrite (Write CoE SDO) instruction.  

Slave unit There are various types of slaves such as Servo Drives that 
handle position data and I/O terminals that handle the bit 
signals.  
The slave unit receives output data sent from the master, and 
sends input data to the master.  

Node address A node address is an address to identify a unit connected to 
EtherCAT.  

ESI file 
(EtherCAT Slave Information 
file) 

The ESI files contain information unique to the EtherCAT slaves 
in XML format.  
Installing an ESI file enables the Sysmac Studio to allocate 
slave process data and make other settings.  
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3. Precautions 
 
(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing safety 
circuit in order to ensure safety and minimize risks of abnormal occurrence.  

(2) To ensure system safety, make sure to always read and heed the information provided in 
all Safety Precautions and Precautions for Safe Use of manuals for each device which is 
used in the system.  

(3) The user is encouraged to confirm the standards and regulations that the system must 
conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this 
document without the permission of OMRON Corporation.  

(5) The information contained in this document is current as of April 2015. It is subject to 
change without notice for improvement.  

 
The following notation is used in this document.  
 

 

Indicates a potentially hazardous situation which, if not avoided, 
could result in death or serious injury. Additionally, there may be 
severe property damage.  

 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury, or property damage.  

 

 Precautions for Correct Use 

Precautions on what to do and what not to do to ensure proper operation and performance.  

 

 Additional Information 
Additional information to read as required.  
This information is provided to increase understanding or make operation easier.  

 
Symbol 
  

 

The filled circle symbol indicates operations that you must do. 
The specific operation is shown in the circle and explained in text. 
This example shows a general precaution for something that must do. 
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4. Overview 
 
This document describes the procedure for connecting X-SEL Controller 
(XSEL-R/S/RX/SX/RXD/SXD) of IAI to NJ-series Machine Automation Controller (hereinafter 
referred to as Controller) of OMRON via EtherCAT and provides procedure for checking their 
connection. 
Refer to Section 6. EtherCAT Settings and Section 7. EtherCAT Connection Procedure to 
understand the setting method and key points to operate PDO Communications of EtherCAT.  
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 
The applicable devices are as follows: 
 

Manufacturer Name Model 
OMRON NJ-series 

CPU Unit 
NJ501-[][][][] 
NJ301-[][][][] 

IAI X-SEL 
Controller 

XSEL-R/S/RX/SX/RXD/SXD-[]-[][][]-([]I[])-EC-[][][]-[]-[] 

IAI Actuator - 
 

 Precautions for Correct Use 

As applicable devices above, the devices with the models and versions listed in Section 5.2. 
are actually used in this document to describe the procedure for connecting devices and 
checking the connection.  
You cannot use devices with versions lower than the versions listed in Section 5.2.  
To use the above devices with models not listed in Section 5.2. or versions higher than those 
listed in Section 5.2., check the differences in the specifications by referring to the manuals 
before operating the devices.  

 

 
Additional Information 
This document describes the procedure to establish the network connection. It does not 
provide information on operation, installation or wiring method which is not related to the 
connection procedure. It also does not describe the functionality or operation of the devices. 
Refer to the manuals or contact the device manufacturer.  
(IAI Corporation http://www.intelligentactuator.com/) 
This URL is the latest address at the time of this document creation. Contact each device 
manufacturer for the latest information.  

 

 
Additional Information 
Contact IAI Corporation for actuators connectable to X-SEL Controller. 
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5.2. Device Configuration 
The hardware components to reproduce the connection procedure of this document are as 
follows: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Manufacturer Name Model Version 
OMRON CPU Unit 

(Built-in EtherCAT port) 
NJ501-1500 Ver.1.09 

OMRON Power Supply Unit NJ-PA3001  
OMRON Sysmac Studio SYSMAC-SE2[][][] Ver.1.10 
- Personal computer  

(OS: Windows 7) 
-  

- USB cable  
(USB 2.0 type B connector) 

-  

OMRON Ethernet cable (with industrial 
Ethernet connector) 

XS5W-T421-[]M[]-K  

IAI X-SEL Controller XSEL-R-4-60I-60I-60I-60I-
ECDVIA-N1E-2-3 

Rev.1.07 

IAI Actuator ISDBCR-S-I-60-8-200-T2-
X07-A1E-AQ-B 

 

IAI Motor cable CB-X-MA[][][]  
IAI Encoder cable CB-X1-PA[][][]  
IAI RS-232C cable  

(with Emergency Stop Switch) 
CB-ST-E1MW050-EB  

IAI PC Interface Software for X-SEL IA-101-X-MW Ver.11.00.00
.00-E 

IAI ESI file ESI_IAI_SEL_ECT_V_1_0
7_Rev_2.xml 

 

  

USB cable 

LAN cable 

NJ501-1500 
(Built-in EtherCAT port) X-SEL Controller 

RS-232C cable (with Emergency Stop Switch) 

Ethernet cable 

Personal computer  
(Sysmac Studio, 
PC Interface Software for 
X-SEL installed, 
OS: Windows 7) 
 

Actuator 

Motor cable 

Encoder cable 
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 Precautions for Correct Use 

Prepare the ESI file shown in this section beforehand. The latest ESI file can be downloaded 
from the IAI website.  
IAI Corporation http://www.intelligentactuator.com/field-network-configuration-files/ 
Contact IAI if the file is not available.  

 

 Precautions for Correct Use 

The connection line of EtherCAT communications cannot be shared with other Ethernet 
networks.  
Do not use devices for Ethernet such as a switching hub.  
Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or 
higher, and use the shielded connector of Category 5 or higher.  
Connect the cable shield to the connector hood at both ends of the cable.  

 

 Precautions for Correct Use 

Update the Sysmac Studio to the version specified in this section or higher version using the 
auto update function.  
If a version not specified in this section is used, the procedures described in Section 7. and 
subsequent sections may not be applicable. In that case, use the equivalent procedures 
described in this document by referring to the Sysmac Studio Version 1 Operation Manual 
(Cat. No. W504). 

 

 Precautions for Correct Use 

For details on power supply wiring, refer to the X-SEL Controller R/S/RX/SX/RXD/SXD Type 
Operation Manual (ME0313). 

 

 Additional Information 
For information on the specifications of the Ethernet cable and network wiring, refer to 
Section 4. EtherCAT Network Wiring of the NJ-series CPU Unit Built-in EtherCAT(R) Port 
User's Manual (Cat. No. W505). 

 

 Additional Information 
The system configuration in this document uses USB for the connection to the Controller.  
For information on how to install a USB driver, refer to A-1. Driver Installation for Direct USB 
Cable Connection of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504). 
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6. EtherCAT Settings 
 
This section describes the specifications such as parameters and device variables that are set 
in this document.  
Hereinafter, the X-SEL Controller is referred to as the "Destination Device" or the "Slave Unit" 
in some descriptions. 
 
 

6.1. Parameters 
The parameters required for connecting the Controller and the X-SEL Controller via EtherCAT 
are given below. 
This document describes the case that only EtherCAT board is used for the X-SEL Controller 
which is configured as follows:  
・Extension PIO Input32/Output16 NPN Board is already mounted to the I/O slot 1.  
・I/O slot 2 is not mounted. 
・EtherCAT board is already mounted to the Field Network Board (Option) Mounted Position 1. 
・DeviceNet board is already mounted to the Field Network Board (Option) Mounted Position 2. 
 
■Parameters for the X-SEL Controller 

Name Items Set value Remarks 
X-SEL 
Controller 

Node address 1 The node address is set by 
Sysmac Studio.  
Make sure that I/O parameter 
No. 226 is set to 0 in PC 
Interface Software for X-SEL. 
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■Parameters for PC Interface Software for X-SEL 

Name Items 
I/O parameters 

No. Set 
value Remarks 

X-SEL 
Controller 

I/O port assignment type 1 0 Fixed allocation 
(Default) 

I/O slot 1 (Extension PIO Input32/Output16 NPN Board) 
  Fix-Allocated Input Port Start 

No.(I/O1) 
2 64  

  Fix-Allocated Output Port Start 
No.(I/O1) 

3 364  

  Error Monitor(I/O1) 10 0 Do not monitor 
 I/O slot 2 (not mounted) 
  Fix-Allocated Input Port Start 

No.(I/O2) 
4 -1 Not used (Default) 

  Fix-Allocated Output Port Start 
No.(I/O2) 

5 -1 Not used (Default) 

  Error Monitor(I/O2) 11 0 Do not monitor 
 Field Network Board (Option) Mounted Position 1 (EtherCAT board)  
  No. of Remote Input Ports 14 256 (Default) 
  No. of Remote Output Ports 15 256 (Default) 
  Fix-Allocated Input Port Start No. 16 1000 (Default) 
  Fix-Allocated Output Port Start No. 17 4000 (Default) 
  Error Monitor 18 1 Monitor (Default) 
  Node Address 226 0 Default setting 

The node address is set 
by Sysmac Studio.  

  Baud Rate 227 0 Setting unnecessary 
(Default) 

 Field Network Board (Option) Mounted Position 2 (DeviceNet board) 
  No. of Remote Input Ports 231 64  
  No. of Remote Output Ports 232 64  
  Fix-Allocated Input Port Start No. 233 0  
  Fix-Allocated Output Port Start No. 234 300  
  Error Monitor 235 0 No Monitoring 
  Node Address 237 0  
  Baud Rate 238 2  
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6.2. Device Variables 
The PDO communications data for the Destination Device are allocated to the Controller's 
device variables.  
The device variables and the data types are shown below.  
 
■Output area (from Controller to Destination Device) 

Device variable name Data type Description 
E001_Out_OUT00_2003_01 UINT Universal input 
E001_Out_OUT01_2003_02 UINT Universal input 
E001_Out_OUT02_2003_03 UINT Universal input 
E001_Out_OUT03_2003_04 UINT Universal input 
E001_Out_OUT04_2003_05 UINT Universal input 

: : : 
E001_Out_OUT11_2003_0C UINT Universal input 
E001_Out_OUT12_2003_0D UINT Universal input 
E001_Out_OUT13_2003_0E UINT Universal input 
E001_Out_OUT14_2003_0F UINT Universal input 
E001_Out_OUT15_2003_10 UINT Universal input 

 
■Input area (from Destination Device to Controller) 

Device variable name Data type Description 
E001_In_IN00_2004_01 UINT Universal output 
E001_In_IN01_2004_02 UINT Universal output 
E001_In_IN02_2004_03 UINT Universal output 
E001_In_IN03_2004_04 UINT Universal output 
E001_In_IN04_2004_05 UINT Universal output 

: : : 
E001_In_IN11_2004_0C UINT Universal output 
E001_In_IN12_2004_0D UINT Universal output 
E001_In_IN13_2004_0E UINT Universal output 
E001_In_IN14_2004_0F UINT Universal output 
E001_In_IN15_2004_10 UINT Universal output 

 

 Additional Information 
In this document, the X-SEL Controller is used by the default PDO mapping. 

 

 Additional Information 
For details on assignments of input and output areas, refer to Section 3.2. Receiving and 
Forwarding of I/O Signals Necessary for Operation in Chapter 3 Operation of the X-SEL 
Controller R/S/RX/SX/RXD/SXD Type Operation Manual (ME0313). 

 

 Additional Information 
The device variables are named automatically from a combination of the device names and 
the port names.  
The default device names are “E" followed by a serial number that starts from 001.  
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7. EtherCAT Connection Procedure 
 
This section describes the procedure for connecting the Controller to the X-SEL Controller via 
EtherCAT.  
This document explains the procedures for setting up the Controller and the X-SEL Controller 
based on the factory default setting. For the initialization, refer to Section 8. Initialization 
Method.  
 

7.1. Work Flow 
Take the following steps to perform PDO Communications of EtherCAT.  
 

7.2. Setting up the IAI X-SEL Controller   Set up the IAI X-SEL Controller.  
↓   

 7.2.1. Hardware Settings  Set the hardware switches on the X-SEL Controller 
and connect the cables.  

↓   
 7.2.2. Parameter Settings  Set the parameters for the X-SEL Controller.  

↓   
7.3. Setting up the Controller  Set up the Controller.  

↓   
 7.3.1. Starting the Sysmac Studio and 

Installing the ESI File 
 Install the ESI file for the X-SEL Controller in the 

Sysmac Studio.  
↓   

 7.3.2. Setting up the EtherCAT 
Network Configuration 

 Set up the EtherCAT network configuration.  

↓   
 7.3.3. Setting the Device Variables  Set the device variables used for the EtherCAT 

Slave Unit.  
↓   

 7.3.4. Transferring the Project Data  Transfer the project data from the Sysmac Studio to 
the Controller.  

↓   
7.4. Checking the EtherCAT 

Communications 
 Confirm that the PDO communications of EtherCAT 

are performed normally.  
↓   

 7.4.1. Error Reset of the X-SEL 
Controller 

 Reset an error of the X-SEL Controller. 

↓   
 7.4.2. Checking the Connection Status  Check the connection status of the EtherCAT 

network.  
↓   

 7.4.3. Checking the Sent and 
Received Data  

 Confirm that the correct data are sent and received.  
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7.2. Setting up the IAI X-SEL Controller 
Set up the IAI X-SEL Controller.  
 

7.2.1. Hardware Settings 
Set the hardware switches on the X-SEL Controller and connect the cables. 
 

 Precautions for Correct Use 

Make sure that the power supply is OFF when you perform the setting up.  

 

1 Make sure that the power supply 
to the X-SEL Controller is OFF.  
 
*If the power supply is turned 
ON, settings may not be 
applicable as described in the 
following procedures.  

 

2 Check the position of the 
hardware switches and the 
connectors on the front panel of 
the X-SEL Controller by referring 
to the right figure. 

 

 
 
 

(Front panel of X-SEL Controller) 

3 Set the Mode Switch on the front 
of the X-SEL Controller to the 
MANU side. 

  
(X-SEL Controller) 

4 Connect the Actuator to the 
Encoder Connector with the 
Encoder cable, and connect the 
Actuator to the Connector for the 
motor cable with the Motor 
cable. 

        
(Actuator)                (X-SEL Controller)  

EtherCAT port (IN) Panel Window 

AC power supply input 
connector Teaching Connector 

Mode Switch 

Encoder Connector  

Connector for the motor cable 

Encoder Connector 

Connector for the 
motor cable 

Encoder cable 

Motor cable 
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5 Connect the Teaching 
Connector and the serial port of 
the Personal computer with the 
RS-232C cable (with Emergency 
Stop Switch). 

                
   (X-SEL Controller) 

6 Connect the Ethernet cable to 
the EtherCAT port (IN).  

 
 
 
 
Ethernet cable 
 
 
 

        (X-SEL Controller)  

7 Connect the 200 VAC power 
supply to the AC Power Supply 
Input Connector. 
 
For details on the power supply 
wiring, refer to the X-SEL 
Controller R/S/RX/SX/RXD/SXD 
Type Operation Manual 
(ME0313). 

 

(X-SEL Controller (200V AC three phase specification)) 

  

Personal 
computer 

Teaching Connector 

RS-232C cable  
(with Emergency Stop Switch) 

EtherCAT port (IN) 
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7.2.2. Parameter Settings 
Set the parameters for the X-SEL Controller.   
Parameters are set by PC Interface Software for X-SEL. Install the software to the Personal 
computer beforehand.  
 

 Additional Information 
For how to install the software, refer to the PC Software for X-SEL Operation Manual 
(ME0154). 

 

1 Turn ON the power supply to the 
X-SEL Controller. . 

 

2 Start the PC Interface Software 
for X-SEL from the Personal 
computer.  

 

3 When the software starts, the 
Connection Confirmation Dialog 
Box is displayed. 
Select the communications port 
No. in the Port Name Field and 
click the OK Button.  
 
*If there are multiple serial ports 
on the Personal computer, 
display the Windows Device 
Manager, and select the same 
port as the communications 
port No. that the X-SEL 
Controller is connected (COM1 
in this example) shown under 
Ports (COM & LPT). 

 
*To display Device Manager, 
select Device Manager from 
Control Panel.  

 
 

 

4 The Setting of Two or more 
programs start Dialog Box is 
displayed. Check the contents 
and click the OK Button.   
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5 24 VDC power supply is not 
supplied to the standard I/O 
connector. So, a confirmation 
dialog box of abnormal 24-V I/O 
power source is displayed. 
 
Check the contents and click the 
OK Button.  

 

6 The PC Interface Software for 
X-SEL starts.  

 

7 Select Edit from the Parameter 
Menu.  

 

8 The I/O Tab Page in the Edit 
Parameter Dialog Box is 
displayed. Set the parameters 
as shown below.  
 
・No.1: 0 
・No.2: 64 
・No.3: 364 
・No.4: -1 
・No.5: -1 
・No.10: 0 
・No.11: 0 
・No.14: 256 
・No.15: 256 
・No.16: 1000 
・No.17: 4000 
・No.18: 1 
 
*The changed parameter is 
displayed in red. 
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9 Scroll the screen, and set the 
following parameters. 
 
・No.226: 0 
・No.227: 0 
・No.231: 64 
・No.232: 64 
・No.233: 0 
・No.234: 300 
・No.235: 0 
・No.237: 0 
・No.238: 2  

10 After setting the parameters, 

click the  icon (Transmit to 

Controller).  
 

11 A confirmation dialog box is 
displayed. Check the contents 
and click the Yes Button. 

 

12 The Information Dialog Box is 
displayed. Check the contents 
and click the OK Button.  
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13 The dialog box on the right is 
displayed. Select the Write the 
selection data area Option, and 
select the Parameter Check 
Box. Click the Yes Button.  

  

14 The Confirmation Dialog Box is 
displayed. Check the contents 
and click the Yes Button.  

  

15 When the X-SEL Controller 
starts, the dialog box on the right 
is displayed.  

 

16 The dialog box on the right is 
displayed. 
When the X-SEL Controller is 
reconnected to the personal 
computer, the dialog box on the 
right is closed.  

   

17 A confirmation dialog box 
indicating F_BUS Error (FBRS 
link error) is displayed. 
Check the contents and click the 
OK Button.  
 
*At this time, the EtherCAT 
communications are not 
established between the X-SEL 
Controller and the Controller. 
So, the error shown on the right 
is displayed. 
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18 Select Exit from the File Menu 
to exit the PC Interface Software 
for X-SEL. 

 

19 Turn OFF the power supply to 
the X-SEL Controller.  
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7.3. Setting up the Controller 
Set up the Controller.  
 

7.3.1. Starting the Sysmac Studio and Installing the ESI File 
Install the ESI file for X-SEL Controller in the Sysmac Studio. 
Install the Sysmac Studio and USB driver in the Personal computer beforehand.  
 

1 Connect the Ethernet cable to the 
built-in EtherCAT port (PORT2) of 
the Controller, and connect the 
USB cable to the peripheral 
(USB) port. As shown in Section 
5.2. Device Configuration, 
connect the Personal computer, 
the Destination Device, and the 
Controller.  

 

2 Turn ON the power supply to the 
Controller and the X-SEL 
Controller.  

 

3 Start the Sysmac Studio.  
 
*If a confirmation dialog for an 
access right is displayed at start, 
execute a selection to start.  

 

4 The Sysmac Studio starts. Click 
the Connect to Controller 
Button.  

 

USB cable End Cover 

Power Supply Unit 
Ethernet 
cable 

CPU Unit 
Controller 

Personal 
computer 

X-SEL 
controller 
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5 The Connect to Controller Dialog 
Box is displayed.  
Select the Direct connection via 
USB Option for Connection type.  
Uncheck both the Upload the 
project Check Box and the 
Display the Troubleshooting 
Dialog Box Check Box for 
Operation after Connection.  
 
Click the Connect Button.  

 

6 Check the contents and click the 
OK Button if a confirmation dialog 
box on the right is displayed.  
 
*The displayed dialog depends 
on the status of the Controller 
used. Check the contents and 
click the OK or Yes Button to 
proceed with the processing.  

 

7 A dialog box indicating the 
Successfully completed is 
displayed. Check the contents 
and click the OK Button.  
 

 

8 The Auto Connect Project Dialog 
Box is displayed online.  
When an online connection is 
established, a yellow bar is 
displayed on the top of the Edit 
Pane.  
 
The following panes are 
displayed in this window.  
Left: Multiview Explorer 

Top right: Toolbox 

Bottom right: Controller Status Pane 

Middle top: Edit Pane 

The following tab pages are 
displayed at the middle bottom of 
the window.  
Output Tab Page 

Build Tab Page 

 

 

Controller 
Status Pane 

Toolbox 

Multiview 
Explorer Edit Pane 

Build Tab 
Page 

Output Tab 
Page 
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 参考 
For details on online connections to the Controller, refer to Section 6. Online Connections to a 
Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504). 

 
 
 

9 Double-click EtherCAT under 
Configurations and Setup in 
the Multiview Explorer.  

 

10 The EtherCAT Tab Page is 
displayed in the Edit Pane.  

 

11 Right-click Master and select 
Display ESI Library.  

 

12 The ESI Library Dialog Box is 
displayed. Click the this folder 
link.  
 
When the Explorer starts, click 
the Close Button to close the 
dialog box.  
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13 The Explorer starts and a folder 
for installing the ESI file is 
opened. Copy the prepared ESI 
file 
ESI_IAI_SEL_ECT_V_1_07_Re
v_2.xml to this folder.   

 

14 Select Exit from the File Menu 
to exit the Sysmac Studio.  
 
*You need to restart the Sysmac 
Studio after installing the ESI 
file.  

 
 
 
 
 
 
 
 
 
A dialog box asking to save the 
project is displayed. If no need 
to save it, click the No Button.  
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15 In the same way as steps 3 to 
11, restart the Sysmac Studio 
and display the ESI Library 
Dialog Box.  
Click the + Button of 
ESI_IAI_SEL_ECT_V_1_07_Re
v_2 to confirm that SEL-ECT 
Rev:0x00010007 device is 
displayed.  
 
Confirm that an exclamation 
mark (warning) is not displayed.  
 
Click the Close Button. 

 

 

 Precautions for Correct Use 

If an exclamation mark (warning) is displayed for the ESI file, check the name of the ESI file 
and obtain the ESI file with a correct name. If an exclamation mark (warning) is displayed 
even when the name of the ESI file is correct, the file may be corrupted. Contact the device 
manufacturer.  
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7.3.2. Setting up the EtherCAT Network Configuration 
Set up the EtherCAT network configuration.  

 

 

If you cycle the power supply to the Slave Unit in step 6, the devices may 
perform unexpected operation. 
Always confirm safety before you cycle the power supply to the Slave Unit.  

 

1 Right-click Master on the 
EtherCAT Tab Page, and select 
Write Slave Node Address.  
 
*If the EtherCAT Tab Page is not 
displayed on the Edit Pane, 
take step 9 in 7.3.1. Starting 
the Sysmac Studio and 
Installing the ESI File to 
display.  

 
 
 
 
A screen is displayed stating 
"Get information is being 
executed". 

 
 

 

2 The Slave Node Address Writing 
Dialog Box is displayed.  
SEL-ECT Rev:0x00010007 is 
displayed in the Actual network 
configuration.  
 
*If the present value of the node 
address is 0, an error is 
displayed with  mark.  

 

3 Enter 1 in the Set value Field for 
a node address.  
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4 Confirm that no error is 
displayed and the set value is 1.  
Click the Write Button.  

 

5 The Slave Node Address Writing 
Dialog Box is displayed. Check 
the contents and click the Write 
Button.  
 
A screen is displayed stating 
"Slave Node Address Writing is 
being executed.". 
 
 
 
The dialog box on the right is 
displayed. Check the contents 
and click the Close Button.  

 
 

 
 

 

6 Cycle the power supply to the 
Slave Unit.  

 

7 Right-click Master on the 
EtherCAT Tab Page, and select 
Compare and Merge with 
Actual Network Configuration.  
 
 
 
 
 
 
 
 
 
A screen is displayed stating 
"Get information is being 
executed.". 
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8 The Compare and Merge with 
Actual Network Configuration 
Dialog Box is displayed.  
Node address 1 and SEL-ECT 
Rev:0x00010007 are added to 
the Actual network configuration 
after the comparison.  
 
Click the Apply actual network 
configuration Button.  

 

9 A confirmation dialog box is 
displayed. Check the contents 
and click the Apply Button.  
 
 
The dialog box on the right is 
displayed. Click the Close 
Button.  

 

 

 

10 As a node address 1 slave, 
E001 SEL-ECT 
Rev:0x00010007 is added to the 
Network configuration on the 
Sysmac Studio.  
 
 
Confirm that the data above are 
added. Click the Close Button.  

 

 

 

11 Node address 1 and E001 
SEL-ECT Rev:0x00010007 
slave are added to the EtherCAT 
Tab Page on the Edit Pane.  
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7.3.3. Setting the Device Variables 
Set the device variables used for the EtherCAT Slave Unit.  

 

1 Select Offline from the 
Controller Menu.  
 
 
 
 
 
The yellow bar on the top 
disappears.  

 
 

 

2 Select the slave for the node 
address 1 added in the previous 
section on the EtherCAT Tab 
Page.   
Check that the device name is 
E001.  
 
*The device name can be 
arbitrarily changed.  

 

 

3 Double-click I/O Map under 
Configurations and Setup in 
the Multiview Explorer.  

 

4 The I/O Map Tab Page is 
displayed in the Edit Pane.  
Confirm that Node1 is displayed 
in the Position Column and the 
Slave Unit added in the Port 
Column is displayed.  
 
*To manually set a variable 
name for the Slave Unit, click a 
column under the Variable 
Column and enter a name.  
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5 Right-click Node1 and select 
Create Device Variable.  

 

6 The variable names and 
variable types are automatically  
set.  

 
 

 Additional Information 
The device variables are named automatically from a combination of the device names and 
the port names.  
The default device names are “E" followed by a serial number that starts from 001.  

 

 Additional Information 
In this document, device variables are automatically named for a unit (a slave). Device 
variables can also be manually named for ports.  
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7.3.4. Transferring the Project Data 
Transfer the project data from the Sysmac Studio to the Controller.  
 

 
The devices or machines may perform unexpected operation regardless of the 
operating mode of the CPU Unit before you transfer a user program, 
configuration data, setup data, device variables, or values in memory used for 
CJ-series Units from the Sysmac Studio. 
Always confirm safety at the Destination Device before you transfer the project 
data. 

 

 

 
After you transfer the project data, the CPU Unit restarts and communications 
with the EtherCAT slaves are cut off. During the period, the slave outputs 
behave according to the slave settings. Also, the time that communications are 
cut off depends on the EtherCAT network configuration.  
Before you transfer the project data, confirm that the slave settings will not 
adversely affect the device. 

 

 

 

A slave will be reset after performing the synchronization in step 7 and 
subsequent steps, and the device may perform unexpected operation.  
Always confirm safety before performing the synchronization.  

 

 
 

1 Select Check All Programs 
from the Project Menu.  

 

2 The Build Tab Page is displayed.  
Check that "0 Errors" and "0 
Warnings" are displayed in the 
Build Tab Page.  

 

3 Select Rebuild Controller from 
the Project Menu.  
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4 A confirmation dialog box on the 
right is displayed. Confirm that 
there is no problem and click the 
Yes Button.  

 

5 Check that "0 Errors" and "0 
Warnings" are displayed in the 
Build Tab Page.  

 

6 Select Online from the 
Controller Menu.  
 
 
 
 
 
A yellow bar is displayed on the 
top of the Edit Pane.  

 

 

 

7 Select Synchronization from 
the Controller Menu.  

 

8 The Synchronization Dialog Box 
is displayed.  
Confirm that the data to transfer 
(NJ501 in the right dialog box) is 
selected. Then, click the 
Transfer To Controller Button.  
 
*After executing the Transfer To 
Controller, the Sysmac Studio 
data is transferred to the 
Controller and the data is 
compared.  
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9 A confirmation dialog box on the 
right is displayed. Confirm that 
there is no problem and click the 
Yes Button.  
 
A screen stating "Synchronizing" 
is displayed.  
 
A confirmation dialog box on the 
right is displayed. Confirm that 
there is no problem and click the 
No Button.  
 
*Do not return to RUN mode.  

 
 

 
 

 

10 Confirm that the synchronized 
data is displayed with the color 
specified by "Synchronized" 
and a message is displayed 
stating "The synchronization 
process successfully finished.". 
If there is no problem, click the 
Close Button.  
 
*A message stating "The 
synchronization process 
successfully finished." is 
displayed if the Sysmac Studio 
project data coincides with the 
Controller data.  

 
*If the synchronization fails, 
check the wiring and repeat 
from step 1.  
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7.4. Checking the EtherCAT Communications 
Confirm that the PDO communications of EtherCAT are performed normally.  
 

7.4.1. Error Reset of the X-SEL Controller 
Reset an error of the X-SEL Controller. 
 

1 Select Offline from the Controller 
Menu.  
 
 
 
 
The yellow bar on the top disappears.  

 
 

 

2 Turn OFF the power supply to the 
X-SEL Controller and the Controller, 
and turn ON the power supply to 
them again at the same time. 

 

 

 Precautions for Correct Use 

Turn ON the power supply to the X-SEL Controller and the Controller at the same time. To 
normally connect the X-SEL Controller and the Controller via the EtherCAT, the 
communications need to be started while the X-SEL Controller and the Controller are waiting 
each other for the establishment of the EtherCAT communications. 
If you cannot turn ON the power supply at the same time, change the parameter No. 120 
Network Attribute 1 (Time Setting to Wait for EtherCAT(R) Communication Establishment) for 
the X-SEL Controller according to the system you use, and then turn ON the power supply. 
For details, refer to Section 3.5.1. Parameter Setting of the EtherCAT(R) Operation Manual 
XSEL-R/S/RX/SX/RXD/SXD (ME0309). 

 

3 Check that the rdy (Normal 
connection to the Controller) is 
displayed on the Panel Window of 
the front side of the X-SEL Controller. 
 
*Perform step 2 again when the Ed5d 
(Fieldbus error) is displayed on the 
Panel Window. 

 
rdy(rdy): Normal connection to the Controller 

 
ed5d(Ed5d): Fieldbus error 
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4 Select Online from the Controller 
Menu.  
 
 
 
 
A yellow bar is displayed on the top of 
the Edit Pane.  
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7.4.2. Checking the Connection Status 
Check the connection status of the EtherCAT network.  
 

1 Confirm that PDO communications 
via EtherCAT are performed 
normally by checking the LED 
indicators on the Controller.  
 
The LED indicators in normal status 
are as follows:  

NET RUN: Green lit 
NET ERR: Not lit 
LINK/ACT: Yellow flashing 

 

 

 

 

 

2 Check the LED indicators on the 
X-SEL Controller. 
 
The LED indicators in normal status 
are as follows: 

RUN: Green lit 
ERR: Not lit 
Link/Activity: Green flickering 
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7.4.3. Checking the Sent and Received Data 
Confirm that the correct data are sent and received.  
 

 
If you change the values of variables on the Watch Tab Page when the Sysmac 
Studio is online with the CPU Unit, the devices that are connected to output 
units may operate regardless of the operating mode of the CPU Unit.  
Sufficiently confirm safety before you change the values of variables on a Watch 
Tab Page when the Sysmac Studio is online with the CPU Unit.  

 

 

1 Select Watch Tab Page from the 
View Menu.  

 

2 Select the Watch1 Tab.  

 

3 As shown below, enter the following 
name of the variables for 
monitoring. Click the Input Name… 
in the Name Column to enter a new 
name.  

E001_Out_OUT00_2003_01 
E001_In_IN00_2004_01 

 

 

4 Check that the Display format of the 
set variables is Decimal. 

  

5 Check that the Online value is 
displayed in decimal. 

  

6 Open the main window of the PC 
Interface Software for X-SEL. 
 
*For information on how to start a 
PC Interface Software for X-SEL, 
refer to step 2 of Section 7.2.2. 
Parameter Settings.  
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7 Select Extend Input Port from the 
Monitor Menu. 

 

8 The Extend Input Port Window is 
displayed. Click the 10 Button for 
the Cardinal num Field. 

 

9 Check that the value for the Status 
of No. 1000 is 0. 

 

10 Enter 8421 in the Modify Column of 
E001_Out_OUT00_2003_01, and 
press Enter key on the Personal 
computer. 
 
At this time, check that the Online 
value changes to 8421. 

  
 

  

11 Check that the value for the Status 
of No. 1000 is 8421. 
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12 Enter 0 in the Modify Column of 
E001_Out_OUT00_2003_01, and 
press Enter key on the Personal 
computer. 
 
At this time, check that the Online 
value changes to 0. 

 
 

 

13 Check that the value for the Status 
of No. 1000 is 0. 

 

14 Select Extend Output Port from the 
Monitor Menu. 

 

15 The Extend Output Port Window is 
displayed. 
Select the Status of No. 4000, and 
double-click. 

 

16 The Data Input Dialog Box is 
displayed. Enter 100 and click the 
OK Button. 
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17 A Confirmation Dialog Box is 
displayed. Check the contents and 
click the Yes Button. 

 

18 Check that the value for the Status 
of No. 4000 changes to 100. 

 

19 Confirm that the Online value of 
E001_In_IN00_2004_01 changes to 
100 as you set in step 15.  

20 In the same way as steps 15 to 17, 
enter 0 in the Status of No. 4000 in 
the Extend Output Port Window. 
 
Check that the value for the Status 
of No. 4000 changes to 0. 

 

21 Confirm that the Online value of 
E001_In_IN00_2004_01 changes to 
0.   
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8. Initialization Method 
 
This document explains the setting procedure from the factory default setting.  
Some settings may not be applicable as described in this document unless you use the 
devices with the factory default setting.  
 

8.1. Initializing the Controller 
To initialize the settings of the Controller, select Clear All Memory from the Controller Menu of 
the Sysmac Studio. The Clear All Memory Dialog Box is displayed. Check the contents and 
click the OK Button.  
 

 

 
 

8.2. Initializing the IAI X-SEL Controller 
For initialization of the IAI X-SEL Controller, refer to Section 8.4. How to Initialize XSEL-R/S, 
RX/SX, RXD/SXD, SSEL/ASEL/PSEL Parameters (at the time of shipment) of the PC 
Software for X-SEL Operation Manual (ME0154). 
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9. Revision History 
 

Revision 
code 

Date of revision Revision reason and revision page 

01 April 1, 2015 First edition 
   
   

 



2015

                 0415(-)  P549-E1-01
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